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1. What is a computer virus? 

A. A type of hardware malfunction 

B. A malicious software program that 

replicates itself 

C. A harmless computer program 

D. A network error 

ANSWER: B 

 

2. How do viruses typically spread? 

A. Through email attachments 

B. Through infected files 

C. Through the internet 

D. All of the above 

ANSWER: D 

 

3. What is a boot sector virus? 

A. A virus that infects the master boot record 

B. A virus that infects executable files 

C. A virus that infects email attachments 

D. A virus that infects the operating system 

ANSWER: A 

 

4. What is a file virus? 

A. A virus that infects executable files 

B. A virus that infects the boot sector 

C. A virus that infects email attachments 

D. A virus that infects the operating system 

ANSWER: A 

 

5. RAM stands for: 

A. Read Access Memory 

B. Random Access Memory 

C. Read Only Memory 

D. Recordable Access Memory 

ANSWER: B 

 

6. The binary system uses which digits? 

A. 0 and 1 

B. 0, 1, and 2 

C. 0, 1, 2, and 3 

D. 0, 1, 2, 3, and 4 

ANSWER: A 

 

7. Which component is responsible for converting 

digital signals to analog signals for display? 

A. CPU 

B. GPU 

C. RAM 

D. Motherboard 

ANSWER: B 

 

8. Anti-static wrist straps are used to: 

A. Prevent damage to components due to 

static electricity 

B. Improve computer performance 

C. Connect components to the motherboard 

D. Reduce noise 

ANSWER: A 

 

9. A driver is: 

A. A type of hardware 

B. A software program that controls 

hardware 

C. A type of operating system 

D. A user interface 

ANSWER: B 

 

 

 

 

 

 

Computer Hardware Maintenance 



Page | 2 

 

 

 

 

 

10. When installing software, it's important to: 

A. Ignore any prompts or warnings 

B. Read and agree to the license agreement 

C. Install all software without considering 

system requirements 

D. Share the installation file with others 

ANSWER: B 

 

11. An operating system: 

A. Is a type of application software 

B. Manages computer hardware and 

software 

C. Is primarily used for gaming 

D. Is not essential for computer operation 

ANSWER: B 

 

12. Which type of memory is used for temporary 

storage of data? 

A. ROM 

B. RAM 

C. HDD 

D. SSD 

ANSWER: B 

 

13. Before disassembling a computer, it's crucial to: 

A. Unplug it from the power source 

B. Open the case immediately 

C. Remove all software 

D. Take a picture of the internal components 

ANSWER: A 

 

 

 

 

 

 

14. Malware is: 

A. Beneficial software 

B. Malicious software 

C. A type of hardware 

D. A computer game 

ANSWER: B 

 

15. Which type of memory is non-volatile and retains 

data even when the power is off? 

A. RAM 

B. ROM 

C. Cache 

D. Register 

ANSWER: B 

 

16. A device that converts analog signals into digital 

signals is called a: 

A. Modem 

B. Codec 

C. Amplifier 

D. DAC 

ANSWER: A 

 

17. The speed of a CPU is measured in: 

A. Hertz 

B. Bytes 

C. Bits 

D. Watts 

ANSWER: A 

 

18. The expansion slots on a motherboard are used to: 

A. Install additional memory 

B. Install expansion cards 

C. Connect cables 

D. Secure the CPU 

ANSWER: B 
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19. A chipset is: 

A. A type of software 

B. A group of integrated circuits on the 

motherboard 

C. A cooling device 

D. A storage device 

ANSWER: B 

 

20. BIOS stands for: 

A. Basic Input Output System 

B. Binary Input Output System 

C. Built-in Input Output System 

D. Basic Internal Output System 

ANSWER: A 

 

21. Which component is responsible for converting 

digital data into analog signals for audio output? 

A. Sound card 

B. Modem 

C. Amplifier 

D. Speaker 

ANSWER: A 

 

22. A bus is: 

A. A physical channel for data transfer 

B. A type of software 

C. A storage device 

D. A cooling component 

ANSWER: A 

 

23. A case fan is used to: 

A. Improve CPU cooling 

B. Increase storage capacity 

C. Enhance graphics performance 

D. Improve airflow within the case 

ANSWER: D 

24. When organizing cables, it's recommended to: 

A. Use zip ties to bundle cables 

B. Leave cables loose for better airflow 

C. Hide all cables behind the motherboard 

D. Ignore cable management 

ANSWER: A 

 

25. After assembling a computer, it's crucial to: 

A. Immediately turn it on 

B. Check for loose components 

C. Ignore the power supply 

D. Install all software 

ANSWER: B 

 

26. A software patch is used to: 

A. Add new features 

B. Fix minor software issues 

C. Completely reinstall software 

D. Remove unwanted programs 

ANSWER: B 

 

27. Open-source software is: 

A. Always free 

B. Has limited functionality 

C. Cannot be modified 

D. Has publicly accessible source code 

ANSWER: D 

 

28. A backup is a: 

A. Copy of data for recovery purposes 

B. Type of software 

C. Open Source 

D. Internet connection 

ANSWER: A 
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29. A software suite is a collection of: 

A. Hardware components 

B. Related software applications 

C. Drivers 

D. Operating systems 

ANSWER: B 

 

30. What is the difference between a full installation 

and a custom installation? 

A. Full installation installs all components, 

while custom allows selecting specific 

features. 

B. Full installation is faster, while custom is 

slower. 

C. Full installation requires more disk space, 

while custom requires less. 

D. There is no difference between the two. 

ANSWER: A 

 

31. What is a GUI? 

A. A text-based interface for interacting with 

a computer 

B. A graphical interface for interacting with 

a computer 

C. A programming language 

D. A type of hardware 

ANSWER: B 

 

32. Which of the following is an example of a GUI 

element? 

A. Command prompt 

B. Icon 

C. CLI 

D. Terminal 

ANSWER: B 

 

 

 

33. What is the purpose of a desktop environment? 

A. To provide a graphical interface for users 

B. To manage hardware resources 

C. To run applications in the background 

D. To control network connections 

ANSWER: A 

 

34. What is a window manager? 

A. A software application that controls the 

placement and appearance of windows 

B. A hardware component that manages the 

display 

C. A type of input device 

D. A network protocol 

ANSWER: A 

 

35. What is a widget? 

A. A small graphical element that performs a 

specific function 

B. A type of software application 

C. A hardware component 

D. A network protocol 

ANSWER: A 

 

36. Which of the following is an example of a CLI 

command? 

A. Click on the "Start" button 

B. Type "ls" to list files and directories 

C. Double-click on an icon 

D. Drag and drop a file 

ANSWER: B 

 

 

 

 

 



Page | 5 

 

 

 

 

 

37. What is a shell? 

A. A hardware component 

B. A software application that provides a 

CLI interface 

C. A programming language 

D. A network protocol 

ANSWER: B 

 

38. What is Linux? 

A. A type of hardware 

B. A programming language 

C. An operating system 

D. A network protocol 

ANSWER: C 

 

39. Which of the following is a Linux distribution? 

A. Windows 

B. macOS 

C. Ubuntu 

D. Microsoft Office 

ANSWER: C 

 

40. What is the kernel of an operating system? 

A. The core component that manages 

hardware and software 

B. A user interface 

C. A type of application software 

D. A network protocol 

ANSWER: A 

 

41. What is a process? 

A. A running instance of a program 

B. A type of hardware 

C. A file system 

D. A network protocol 

ANSWER: A 

42. What is the purpose of the "mkdir" command in 

Linux? 

A. Make directory 

B. Move directory 

C. Modify directory 

D. Delete directory 

ANSWER: A 

 

43. What is the purpose of the "rm" command in 

Linux? 

A. Remove file or directory 

B. Rename file or directory 

C. Read file 

D. Write to file 

ANSWER: A 

 

44. What is the purpose of the "cp" command in 

Linux? 

A. Copy files or directories 

B. Create files or directories 

C. Compare files 

D. Delete files or directories 

ANSWER: A 

 

45. What is the primary function of Microsoft Word? 

A. Creating spreadsheets 

B. Creating presentations 

C. Creating documents 

D. Managing databases 

ANSWER: C 
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46. What is the primary function of Microsoft Excel? 

A. Creating spreadsheets 

B. Creating presentations 

C. Creating documents 

D. Managing databases 

ANSWER: A 

 

47. What is the primary function of Microsoft 

PowerPoint? 

A. Creating spreadsheets 

B. Creating presentations 

C. Creating documents 

D. Managing databases 

ANSWER: B 

 

48. What is a database? 

A. A collection of organized information 

B. A type of software application 

C. A hardware component 

D. A network protocol 

ANSWER: A 

 

49. What is a spreadsheet? 

A. A document containing text and images 

B. A table of organized data 

C. A presentation with slides 

D. A database for storing information 

ANSWER: B 

 

50. What is a chart in a spreadsheet? 

A. A graphical representation of data 

B. A formula for calculating values 

C. A database table 

D. A text format 

ANSWER: A 

51. What is a presentation? 

A. A collection of slides containing text, 

images, and multimedia 

B. A document containing text and images 

C. A spreadsheet with data 

D. A database for storing information 

ANSWER: A 

 

52. What is OpenOffice? 

A. A web browser 

B. An operating system 

C. A free and open-source office suite 

D. A programming language 

ANSWER: C 

 

53. Which of the following is NOT a core component 

of OpenOffice? 

A. Writer 

B. Excel 

C. Calc 

D. Impress 

ANSWER: B 

 

54. What is the purpose of the toolbar in OpenOffice 

applications? 

A. To display the document content 

B. To provide quick access to common 

commands 

C. To manage files 

D. To edit text 

ANSWER: B 
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55. What is the purpose of styles in OpenOffice 

Writer? 

A. To format text consistently 

B. To create tables 

C. To insert images 

D. To check spelling 

ANSWER: A 

 

56. How do you insert a table in OpenOffice Writer? 

A. Use the "Insert" -> "Table" menu 

B. Press the "Tab" key multiple times 

C. Use the "Draw" toolbar 

D. All of the above 

ANSWER: A 

 

57. What is the function of the AVERAGE function 

in OpenOffice Calc? 

A. Adds a range of numbers 

B. Averages a range of numbers 

C. Counts the number of cells 

D. Finds the maximum value 

ANSWER: B 

 

58. What is a filter in OpenOffice Calc? 

A. A way to display only specific data based 

on criteria 

B. A type of chart 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 

 

 

 

 

 

 

59. What is a conditional formatting in OpenOffice 

Calc? 

A. Applying specific formatting based on 

certain conditions 

B. A type of chart 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 

 

60. What is the default file extension for a 

presentation created in OpenOffice Impress? 

A. .pptx 

B. .ppt 

C. .odp 

D. .pdf 

ANSWER: C 

 

61. What is a shape in OpenOffice Draw? 

A. A basic geometric object 

B. A text box 

C. A picture 

D. A line 

ANSWER: A 

 

62. How do you insert a picture into OpenOffice 

Draw? 

A. Use the "Insert" -> "Picture" menu 

B. Copy and paste the picture 

C. Drag and drop the picture 

D. All of the above 

ANSWER: D 
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63. What is a connector in OpenOffice Draw? 

A. A line that connects two objects 

B. A type of shape 

C. A text box 

D. A picture 

ANSWER: A 

 

64. What is a layer in OpenOffice Draw? 

A. A way to organize objects 

B. A type of shape 

C. A text box 

D. A picture 

ANSWER: A 

 

65. What is OpenOffice Base used for? 

A. Creating databases 

B. Creating spreadsheets 

C. Creating presentations 

D. Creating diagrams 

ANSWER: A 

 

66. What is a device driver? 

A. A software program that allows the 

operating system to communicate with 

hardware 

B. A type of hardware component 

C. A file system 

D. A network protocol 

ANSWER: A 

 

 

 

 

 

 

 

67. How can you update a device driver? 

A. Through the Device Manager 

B. By downloading the driver from the 

manufacturer's website 

C. Both A and B 

D. Neither A nor B 

ANSWER: C 

 

68. What is a file system? 

A. A method of organizing and storing files 

on a storage device 

B. A physical division of a hard drive 

C. A logical division of a partition 

D. A type of file 

ANSWER: A 

 

69. What is the purpose of disk checking? 

A. Checking for errors on the hard drive 

B. Deleting unnecessary files 

C. Combining fragmented files into 

contiguous blocks 

D. Creating a backup of the hard drive 

ANSWER: A 

 

70. What is the purpose of the subscription feature in 

the Event Viewer? 

A. To receive notifications when specific 

events occur 

B. To save event logs automatically 

C. To filter events based on specific criteria 

D. To clear event logs automatically 

ANSWER: A 
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71. How can you uninstall a device in the Device 

Manager? 

A. Right-click the device and select 

"Uninstall device" 

B. Delete the device's driver file 

C. Disconnect the device from the computer 

D. Use the "Uninstall" program 

ANSWER: A 

 

72. What is the primary function of an antivirus 

program? 

A. Protecting a computer from viruses and 

malware 

B. Speeding up a computer 

C. Increasing storage capacity 

D. Improving internet speed 

ANSWER: A 

 

73. How do antivirus programs protect computers? 

A. By detecting and removing viruses 

B. By preventing virus infections 

C. By repairing damaged files 

D. All of the above 

ANSWER: D 

 

74. What is a virus signature? 

A. A unique pattern of code that identifies a 

virus 

B. A type of antivirus software 

C. A computer hardware component 

D. A network protocol 

ANSWER: A 

 

 

 

 

 

75. What is real-time protection? 

A. An antivirus feature that constantly 

monitors a computer for threats 

B. A type of antivirus software 

C. A hardware component 

D. A network protocol 

ANSWER: A 

 

76. What is a worm? 

A. A self-replicating program that spreads 

through networks 

B. A virus that infects executable files 

C. A type of antivirus software 

D. A hardware component 

ANSWER: A 

 

77. What is a Trojan horse? 

A. A malicious program disguised as 

legitimate software 

B. A self-replicating program 

C. A virus that infects the boot sector 

D. A type of antivirus software 

ANSWER: A 

 

78. What is a spyware? 

A. Software that collects information about a 

user without their consent 

B. A self-replicating program 

C. A virus that infects executable files 

D. A type of antivirus software 

ANSWER: A 
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79. What is a ransomware? 

A. Malware that encrypts files and demands 

a ransom to decrypt them 

B. A self-replicating program 

C. A virus that infects executable files 

D. A type of antivirus software 

ANSWER: A 

 

80. What is a malware? 

A. A general term for malicious software 

B. A specific type of virus 

C. A hardware component 

D. A network protocol 

ANSWER: A 

 

81. What is adware? 

A. Software that displays unwanted ads 

B. A virus that infects executable files 

C. A type of antivirus software 

D. A hardware component 

ANSWER: A 

 

82. Why is preventive maintenance important? 

A. To extend the life of hardware 

components 

B. To improve computer performance 

C. To prevent data loss 

D. All of the above 

ANSWER: D 

 

 

 

 

 

 

 

83. What is cleaning computer hardware? 

A. Removing dust and debris from 

components 

B. Replacing damaged components 

C. Upgrading the operating system 

D. Installing new software 

ANSWER: A 

 

84. How often should computer hardware be cleaned? 

A. Once a year 

B. Every six months 

C. Every three months 

D. Monthly 

ANSWER: C 

 

85. What is thermal paste used for? 

A. Cooling the CPU 

B. Cleaning the keyboard 

C. Lubricating moving parts 

D. Protecting against static electricity 

ANSWER: A 

 

86. What is a hardware driver? 

A. A software program that allows the 

operating system to communicate with 

hardware 

B. A type of hardware component 

C. A file system 

D. A network protocol 

ANSWER: A 
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87. What is BIOS? 

A. Basic Input/Output System 

B. Binary Input/Output System 

C. Basic Internal Output System 

D. Built-in Input/Output System 

ANSWER: A 

 

88. What is a CPU? 

A. Central Processing Unit 

B. Control Processing Unit 

C. Computer Processing Unit 

D. Core Processing Unit 

ANSWER: A 

 

89. What is a GPU? 

A. Graphics Processing Unit 

B. General Processing Unit 

C. Game Processing Unit 

D. Graphical Processing Utility 

ANSWER: A 

 

90. What is a motherboard? 

A. The main circuit board of a computer 

B. A storage device 

C. A type of processor 

D. A cooling component 

ANSWER: A 

 

91. What is a power supply unit (PSU)? 

A. Provides power to the computer 

components 

B. Stores data 

C. Processes information 

D. Displays output 

ANSWER: A 

92. What is a hard disk drive (HDD)? 

A. A type of primary storage 

B. A type of output device 

C. A type of input device 

D. A type of network device 

ANSWER: A 

 

93. What is a solid-state drive (SSD)? 

A. A type of primary storage with no 

moving parts 

B. A type of optical storage 

C. A type of input device 

D. A type of output device 

ANSWER: A 

 

94. What is a RAM? 

A. Random Access Memory 

B. Read-Only Memory 

C. Read Access Memory 

D. Removable Access Memory 

ANSWER: A 

 

95. How often should you back up your data? 

A. Once a year 

B. Every six years 

C. Never 

D. Regularly, based on data importance 

ANSWER: D 

 

96. What is a hacker? 

A. Someone who breaks into computer 

systems 

B. A computer programmer 

C. A network administrator 

D. A hardware technician 

ANSWER: A 
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97. What is the purpose of a wire stripper? 

A. To remove the outer jacket of a cable 

B. To crimp connectors onto wires 

C. To test network cables 

D. To connect computers to a network 

ANSWER: A 

 

98. Which type of malware is designed to replicate 

itself and spread to other systems? 

A. Trojan 

B. Virus 

C. Spyware 

D. Adware 

ANSWER: B 

 

99. Which of the following is/are true for Linux? 

A. Linux is an operating system or a kernel, 

it is open source and supports all kinds of 

hardware components. 

B. It is like the Unix system. 

C. Linux has a GUI system 

D. All mentioned are true 

ANSWER: D 

 

100. The user interface allows the user to 

communicate with the OS. Which of the 

following is/are example if interfaces: 

A. Command Line Interface,Graphical User 

Interface (GUI)and Menu-driven 

B. Command Line Interface,Graphical User 

Interface (GUI) 

C. Command Line Interface,Graphical User 

Interface (GUI),Menu-driven,Form-based 

and Natural language 

ANSWER: C 

 

 

 

101. The purpose of taskbar in GUI element is: 

A. To show all the system task running in 

past. 

B. To show which programming is running 

currently in the system. 

C. To show all the directories present in the 

system 

D. All are true 

ANSWER: B 

 

102. pwd command in Linux OS does which 

of the following: 

A. It prints the path of the working directory, 

starting from the root. 

B. It is shell built-in command(pwd) or an 

actual binary(/bin/pwd). 

C. It is an environment variable which stores 

the path of the current directory. 

D. All are true 

ANSWER: D 

 

103. _____________ is the main package 

management program in Debian used to install, 

build, remove, and manage packages. 

A. chmod 

B. fdisk 

C. dpkg 

D. Whatis 

ANSWER: C 
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104. Which of the following Operating System 

is not type of Linux? 

A. BSD 

B. Ubuntu 

C. Redhat 

D. CentOS 

ANSWER: A 

 

105. The Linux command ______________ 

tape archive, is used to create Archive and extract 

the Archive files 

A. tar 

B. xvgh 

C. rmdir 

D. gzip 

ANSWER: A 

 

106. Taskbar is used for 

A. Navigation program 

B. Switching between program 

C. Start a program 

D. All of mentioned 

ANSWER:D 

 

107. Folder may contain: 

A. Files and sub folders 

B. Only files 

C. Only sub folders 

D. None of the mentioned 

ANSWER:A 

 

 

 

 

 

 

108. Most widely used Text Editor is________ 

A. Wordpad 

B. Paint 

C. Photoshop 

D. Notepad 

ANSWER: D 

 

109. Collection of related files and subfolders 

is_______ 

A. Menu 

B. Disk 

C. Operating System 

D. Folder 

ANSWER:D 

 

110. One Gigabyte (GB) is equal to_______- 

A. 1024 bytes 

B. 1024 KB 

C. 1024 MB 

D. 1024 TB 

ANSWER:C 

 

111. A _______________ is an all-purpose 

knife used for cutting. 

A. Metal Vise 

B. Steel File 

C. Utility knife 

D. Chalk Line 

ANSWER: C 

 

112. Which of the following is a hand tool? 

A. Bubble levels 

B. All of the mentioned 

C. Spanner 

D. Pliers 

ANSWER: B 
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113. ______________ protects the eyes from 

all directions during machining. 

A. Speed Square 

B. Safety goggles 

C. Respirator 

D. Face shield 

ANSWER: B 

 

114. An electronic tool that allows information 

to be input, processed, and output 

A. Operating Systems 

B. Motherboard 

C. Computer 

D. CPU 

ANSWER: C 

 

115. Which of the following tasks can be done 

on a modern computer? 

A. Complex calculations 

B. Internet surfing 

C. All of the mentioned 

D. Watch movies 

ANSWER: C 

 

116. The physical part of the computer is 

known as 

A. Hardware 

B. Software 

C. Internet 

D. Protocol 

ANSWER: A 

 

 

 

 

 

117. Which of the following is a part of the 

CPU 

A. Mouse 

B. Keyboard 

C. Desktop 

D. Arithmetic Logic Unit 

ANSWER: D 

 

118. If you turn ON a PC and the unit is 

clearly ON but the monitor is dark, the problem 

could be that: 

A. The monitor is not plugged in 

B. The monitor is not turned on 

C. The monitor is not plugged into the PC 

D. Any or all of the mentioned 

ANSWER: D 

 

119. If a PC behaves freezes or behaves 

erratically and the system unit is very quiet, there 

is a chance that 

A. A virus has infected the system 

B. The RAM of the system is failing 

C. The power supply fan has failed and the 

system is overheating 

D. The hard drive is almost out of space 

ANSWER: C 

 

120. The hardware in a PC that keeps track of 

the hardware resources of the system is called 

A. CMOS-RAM 

B. Motherboard 

C. ROM BIOS CHIP 

D. Power Supply 

ANSWER: B 
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121. A message saying “Invalid drive 

configuration” appears during the bootup of a PC. 

The problem most likely could be 

A. The hard drive cable is not attached to the 

controller 

B. The hard drive has failed 

C. The hard drive has no partitions 

D. Any of the mentioned 

ANSWER: D 

 

122. You have loaded a new video card on 

your computer and now everything looks really 

bad. What should you do first? 

A. Check the log in the event viewer 

B. View the device manager and see if the 

card is configured correctly. 

C. Go to the printed manual 

D. Restart the computer 

ANSWER: B 

 

123. Which of the following should be done 

first to remove an application that you no longer 

need? 

A. Delete the program files 

B. Use the uninstall program that came with 

the application 

C. Use the add or remove programs feature 

D. Use the registry editor to remove the 

references to the program 

ANSWER: B 

 

124. Which utility is useful to identify the 

program that is hogging the processing resources 

of the computer? 

A. Device Manager 

B. System Monitor 

C. Task Manager 

D. System Information 

ANSWER: C 

125. What program can be used to keep your 

system up to date and patched up? 

A. Windows dispatcher 

B. Windows Upgrade 

C. Windows Update 

D. Device Manager 

ANSWER: C 

 

126. What do we call the power protection 

device that has a battery and provides a few 

minutes of power? 

A. Generator 

B. UPS 

C. Line conditioner 

D. Surge suppressor 

ANSWER: B 

 

127. What is the measurement unit of 

resistance? 

A. Ohms 

B. Watts 

C. Volts 

D. Amperes 

ANSWER: A 

 

128. Different components of the motherboard 

of a PC are linked together by a set of parallel 

electrical conducting lines. What are these lines 

called? 

A. Buses 

B. Connectors 

C. Conductors 

D. Drivers 

ANSWER: A 
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129. RS-232 is a standard that applies to? 

A. Serial Communication 

B. Parallel Communication 

C. Audio ports 

D. Network ports 

ANSWER: A 

 

130. In computer terminology, VGA stands 

for? 

A. Volatile Graphics Access 

B. Video Graphics Array 

C. Video Graphics Adapter 

D. Voltage Graph Adapter 

ANSWER: B 

 

131. What is the software that controls system 

performances called? 

A. Overlay Software 

B. System Software 

C. Control Software 

D. Application Software 

ANSWER: B 

 

132. A program is 

A. a device where information is stored 

B. control system that controls the ALU 

C. a sequence of instructions 

D. None of the mentioned 

ANSWER: C 

 

 

 

 

 

 

 

133. ___________ is designed to solve a 

specific problem or execute a specific task. 

A. Utility software 

B. User software 

C. Application software 

D. System software 

ANSWER: C 

 

134. Special Purpose Softwares are also called 

A. System Softwares 

B. Utility Softwares 

C. Application Softwares 

D. User Interface 

ANSWER: C 

 

135. In a computer, an Operating System is an 

example of 

A. System Software 

B. Device drivers 

C. Application Softwares 

D. Custom Softwares 

ANSWER: A 

 

136. Choose the two main types of software 

from the following. 

A. Operating System and Device drivers 

B. LINUX and UNIX 

C. Application and System 

D. Windows and macOS 

ANSWER: C 
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137. Which of the following is NOT an 

Operating System? 

A. Windows 

B. Android 

C. Ubuntu 

D. None of the mentioned 

ANSWER: D 

 

138. linux is a(an)______Operating System 

A. Microsoft 

B. Mac 

C. Open source 

D. Solaris 

ANSWER:C 

 

139. Which command will display the system 

date? 

A. Date 

B. Ver 

C. Dir 

D. Format 

ANSWER:A 

 

140. Not based Linux OS is________ 

A. Ubuntu 

B. Redhat 

C. CentOs 

D. BSD 

ANSWER:D 

 

141. Abbreviation of GUI? 

A. Giga uses internet 

B. Geographical user interface 

C. Graphical User interface 

D. Graphical unlimited interface 

ANSWER:C 

142. Cursor is a___________ 

A. Pixel 

B. Thin blinking line 

C. Pointing indicator 

D. None of mentioned 

ANSWER:C 

 

143. Run command for Calculator to open 

A. cals 

B. calc 

C. calee 

D. cal 

ANSWER:B 

 

144. Recently deleted files are stored in which 

place? 

A. Desktop 

B. Recycle bin 

C. Taskbar 

D. My Computer 

ANSWER:B 

 

145. Open Office is 

A. Application Software 

B. System Software 

C. Operating System 

D. All of the mentioned 

ANSWER:A 

 

146. Navigating one page to another page is 

called______ 

A. Hyperlink 

B. Menu 

C. Source drive 

D. None of mentioned 

ANSWER:A 
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147. What is the shortcutkey used for "Open 

File" in Word 

A. Ctrl+F 

B. Ctrl+H 

C. Ctrl+O 

D. Ctrl+S 

ANSWER:C 

 

148. Text-style feature of word is 

A. WordColor 

B. WordFont 

C. WordArt 

D. WordFill 

ANSWER:C 

 

149. A disk that has a boot partition is called 

as _________ 

A. start disk 

B. end disk 

C. boot disk 

D. All of the mentioned 

ANSWER: C 

 

150. File virus attaches itself to the file 

_____________ 

A. source file 

B. object file 

C. executable file 

D. all of the mentioned 

ANSWER:C 

 

 

 

 

 

 

151. A joystick is primarily used to/for 

A. Computer Gaming 

B. Control sound on screen 

C. Enter text 

D. Draw pictures 

ANSWER: A 

 

152. Which of the following is not hardware? 

A. Mouse 

B. Motherboard 

C. Printer 

D. Java 

ANSWER: D 

 

153. Which System Software acts as a link 

between the hardware and the software on a 

computer? 

A. Operating System 

B. Device drivers 

C. Utility Software 

D. Firmware 

ANSWER: A 

 

154. mv command used for which purpose? 

A. Renaming a file 

B. Move the file to different directory. 

C. None of the mentioned 

D. Both A and B 

ANSWER:D 
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155. Which of the following is primarily 

responsible for converting input (data) into 

meaningful output (information)? 

A. RAM 

B. CPU 

C. Storage device 

D. Input and Output device 

ANSWER: B 

 

156. Which device is mostly used to enter data 

or information in a computer system? 

A. Touch screen 

B. mouse 

C. light pen 

D. keyboard 

ANSWER: D 

 

157. Which of the following is not a type of 

mouse? 

A. Wireless mouse 

B. Optical mouse 

C. Mechanical mouse 

D. Electromechanical mouse 

ANSWER: D 

 

158. Which memory unit communicates 

directly with the CPU? 

A. Main memory 

B. Register 

C. Secondary memory 

D. Auxiliary memory 

ANSWER: A 

 

 

 

 

 

159. Which of the following components 

remains on the motherboard? 

A. CMOS battery 

B. PCI slot 

C. Case fan 

D. Expansion slot 

E. All of these 

ANSWER: E 

 

160. Which button is known as a middle 

button used as the third mouse button? 

A. Right button 

B. Left button 

C. Scroll wheel 

D. None of these 

ANSWER: C 

 

161. Through what hardware does one person 

speak to the other person on a video conference? 

A. Speaker                 

B. Monitor                  

C. Microphone          

D. Camera 

ANSWER: C 

 

162. The device that produces hard copies on 

paper is called ______. 

A. monitor     

B. scanner 

C. tablet         

D. printer 

ANSWER: D 
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163. External devices/ peripherals like 

keyboard and mouse can be connected to a 

computer using ______ ports. 

A. PS/2 

B. USB 

C. both A & B 

D. neither A nor B 

ANSWER: C 

 

164. Which is not a valid file system? 

A. FAT 16 

B. FAT 32 

C. NTFS 

D. FXZ 

ANSWER: D 

 

165. Which file system DOS typically use? 

A. FAT 16 

B. FAT 32 

C. NTFS 

D. LMFS 

ANSWER: A 

 

166. Which command changes a file’s group 

owner 

A. cgrp 

B. chgrp 

C. change 

D. group 

ANSWER: B 

 

 

 

 

 

 

167. Which command is used to display disk 

consumption of a specific directory 

A. du 

B. ds 

C. dd 

D. dds 

ANSWER: A 

 

168. The file system "NTFS" stands for 

A. New Type File System 

B. Never Terminated File System 

C. New Technology File System 

D. Non Terminated File System 

ANSWER: C 

 

169. What is a scareware? 

A. Malware that tries to trick users into 

buying unnecessary software 

B. A type of antivirus software 

C. A hardware component 

D. A network protocol 

ANSWER: A 

 

170. The primary function of the CPU is: 

A. Storing data 

B. Processing data 

C. Inputting data 

D. Outputting data 

ANSWER: B 
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171. Which storage device is typically the 

fastest? 

A. Hard Disk Drive (HDD) 

B. Solid State Drive (SSD) 

C. Optical Disk Drive (ODD) 

D. Magnetic Tape 

ANSWER: B 

 

172. When installing a CPU, it's essential to 

align: 

A. The pins on the CPU with the socket 

B. The heatsink with the fan 

C. The RAM slots with the CPU 

D. The power supply connectors with the 

motherboard 

ANSWER: A 

 

173. The primary function of a motherboard is: 

A. Processing data 

B. Storing data 

C. Connecting computer components 

D. Displaying output 

ANSWER: C 

 

174. Which component is responsible for 

storing the BIOS? 

A. RAM 

B. ROM 

C. HDD 

D. SSD 

ANSWER: B 

 

 

 

 

 

175. A graphics card is primarily used for: 

A. Processing text 

B. Processing audio 

C. Processing images and video 

D. Storing data 

ANSWER: C 

 

176. A thermal paste should be: 

A. Thickly applied to the CPU 

B. Applied in a thin, even layer 

C. Not used at all 

D. Applied to the heatsink 

ANSWER: B 

 

177. When installing a graphics card, it's 

essential to: 

A. Use a screwdriver to tighten screws 

B. Align the PCIe slot correctly 

C. Install the card before the CPU 

D. Apply thermal paste to the graphics card 

ANSWER: B 

 

178. A software update is typically used to: 

A. Remove unwanted features 

B. Fix bugs and improve performance 

C. Increase hardware requirements 

D. Reduce software functionality 

ANSWER: B 

 

179. Freeware is software that: 

A. Has a high cost 

B. Requires payment after a trial period 

C. Can be used without payment 

D. Is only available for specific operating 

systems 

ANSWER: C 
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180. Shareware is software that: 

A. Can be used freely without limitations 

B. Requires payment after a trial period 

C. Is always free 

D. Is only available for specific hardware 

ANSWER: B 

 

181. Which component acts as the 

intermediary between the CPU and main 

memory? 

A. Hard disk 

B. Cache 

C. Motherboard 

D. GPU 

ANSWER: B 

 

182. The cooling system in a computer is 

essential to: 

A. Improve performance 

B. Reduce noise 

C. Prevent overheating 

D. Increase storage capacity 

ANSWER: C 

 

183. Before installing a CPU, it's important to: 

A. Apply thermal paste directly to the CPU 

B. Check for bent pins 

C. Install the RAM first 

D. Connect the power supply 

ANSWER: B 

 

 

 

 

 

 

184. When installing RAM, it's crucial to: 

A. Use excessive force 

B. Align the notches correctly 

C. Install all RAM sticks in the same slot 

D. Apply thermal paste to the RAM 

ANSWER: B 

 

185. A standoff is used to: 

A. Improve CPU cooling 

B. Secure the motherboard to the case 

C. Connect cables 

D. Reduce noise 

ANSWER: B 

 

186. Proper grounding is essential to prevent: 

A. Overheating 

B. Static electricity damage 

C. Noise 

D. Software conflicts 

ANSWER: B 

 

187. A peripheral device is: 

A. An internal component of the computer 

B. An external device connected to the 

computer 

C. A software application 

D. A type of memory 

ANSWER: B 
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188. When installing a power supply unit, it's 

important to: 

A. Connect all cables before securing the 

PSU 

B. Align the mounting holes correctly 

C. Install the PSU before the motherboard 

D. Apply thermal paste to the PSU 

ANSWER: B 

 

189. A software update is often delivered 

through: 

A. Physical media 

B. Email 

C. Online download 

D. Hardware upgrade 

ANSWER: C 

 

190. Overclocking a CPU means: 

A. Reducing its clock speed 

B. Increasing its clock speed beyond the 

manufacturer's specifications 

C. Underclocking the GPU 

D. Adding more cores to the CPU 

ANSWER: B 

 

191. A heat sink is used to: 

A. Increase CPU performance 

B. Reduce noise 

C. Dissipate heat from the CPU 

D. Store data 

ANSWER: C 

 

 

 

 

 

192. When uninstalling software, it's important 

to: 

A. Delete the software folder manually 

B. Use the operating system's uninstaller 

C. Restart the computer before uninstalling 

D. Ignore any prompts or warnings 

ANSWER: B 

 

193. What is a software dependency? 

A. A requirement for specific hardware 

components. 

B. A requirement for other software to 

function correctly. 

C. A need for internet connection during 

installation. 

D. A limitation on the number of users. 

ANSWER: B 

 

194. What is the purpose of a software 

registry? 

A. Stores user preferences and settings. 

B. Manages hardware drivers. 

C. Controls the operating system. 

D. All of the above. 

ANSWER: A 

 

195. What is a silent installation? 

A. An installation that requires no user 

interaction. 

B. An installation that is very quiet. 

C. An installation that does not require 

administrative privileges. 

D. An installation that installs only essential 

files. 

ANSWER: A 
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196. What is the purpose of the "cd" command 

in Linux? 

A. Change directory 

B. Create directory 

C. Copy directory 

D. Delete directory 

ANSWER: A 

 

197. What is the purpose of the "ls" command 

in Linux? 

A. List files and directories 

B. Create a file 

C. Copy a file 

D. Delete a file 

ANSWER: A 

 

198. What is the purpose of the "mv" 

command in Linux? 

A. Move or rename files or directories 

B. Modify files or directories 

C. Make a copy of files or directories 

D. Delete files or directories 

ANSWER: A 

 

199. What is the purpose of the "cat" 

command in Linux? 

A. Create a file 

B. Append text to a file 

C. Display the contents of a file 

D. Delete a file 

ANSWER: C 

 

 

 

 

 

200. What is a shell script? 

A. A graphical user interface script 

B. A text-based program that runs in a shell 

environment 

C. A programming language 

D. A type of hardware 

ANSWER: B 

 

201. What is the purpose of the "if" statement 

in a shell script? 

A. To perform conditional execution 

B. To create loops 

C. To define functions 

D. To manipulate variables 

ANSWER: A 

 

202. What is a variable in a shell script? 

A. A named storage location for data 

B. A keyword 

C. A function 

D. A control structure 

ANSWER: A 

 

203. What is the purpose of the "while" loop in 

a shell script? 

A. To perform conditional execution 

B. To create loops 

C. To define functions 

D. To manipulate variables 

ANSWER: B 
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204. What is a function in a shell script? 

A. A reusable block of code 

B. A variable 

C. A control structure 

D. A command 

ANSWER: A 

 

205. What is a database management system 

(DBMS)? 

A. Software for creating, managing, and 

accessing databases 

B. A type of hardware 

C. A programming language 

D. A network protocol 

ANSWER: A 

 

206. What is a query in a database? 

A. A request for information from a database 

B. A table in a database 

C. A record in a database 

D. A field in a database 

ANSWER: A 

 

207. What is a mail merge in Word? 

A. Combining a document template with a 

data source to create personalized 

documents 

B. Sending an email from within Word 

C. Merging multiple documents into one 

D. Formatting text in a specific style 

ANSWER: A 

 

 

 

 

 

208. What is a macro in Excel? 

A. A pre-defined formula 

B. A recorded series of actions that can be 

automated 

C. A chart type 

D. A data validation rule 

ANSWER: B 

 

209. What is a package manager in Linux? 

A. A software tool for installing, managing, 

and removing software packages 

B. A type of hardware 

C. A programming language 

D. A network protocol 

ANSWER: A 

 

210. What is the purpose of the "xargs" 

command in a shell script? 

A. Builds command lines from standard 

input 

B. Creating files 

C. Modifying file permissions 

D. Changing file ownership 

ANSWER: A 

 

211. What is a pivot chart in Excel? 

A. A graphical representation of pivot table 

data 

B. A type of chart 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 
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212. What is a conditional formatting in 

Excel? 

A. Applying specific formatting based on 

certain conditions 

B. A chart type 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 

 

213. What is a template in Word? 

A. A pre-formatted document that can be 

used as a starting point 

B. A type of chart 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 

 

214. What is a slide transition in PowerPoint? 

A. The animation effect between slides 

B. A chart type 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 

 

215. What is a database query language? 

A. A language used to interact with and 

manipulate databases 

B. A programming language 

C. A scripting language 

D. A markup language 

ANSWER: A 

 

 

 

 

 

216. What is the purpose of the "eval" 

command in a shell script? 

A. To evaluate an expression 

B. To create a function 

C. To handle signals 

D. To change the working directory 

ANSWER: A 

 

217. What is the purpose of the "return" 

statement in a shell script function? 

A. To return a value from the function 

B. To exit the script 

C. To create a loop 

D. To handle signals 

ANSWER: A 

 

218. What is the purpose of the header and 

footer in OpenOffice Writer? 

A. To add text at the top and bottom of each 

page 

B. To format the main document content 

C. To insert images 

D. To create tables 

ANSWER: A 

 

219. What is the basic unit of data in 

OpenOffice Calc? 

A. Cell 

B. Row 

C. Column 

D. Worksheet 

ANSWER: A 
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220. How do you enter a formula in 

OpenOffice Calc? 

A. Start with an equal sign (=) 

B. Use the "Formula" menu 

C. Click the "Formula" button 

D. All of the above 

ANSWER: A 

 

221. What is the function of the SUM function 

in OpenOffice Calc? 

A. Adds a range of numbers 

B. Averages a range of numbers 

C. Counts the number of cells 

D. Finds the maximum value 

ANSWER: A 

 

222. How do you create a chart in OpenOffice 

Calc? 

A. Use the "Insert" -> "Chart" menu 

B. Use the "Data" -> "Chart" menu 

C. Use the "Format" -> "Chart" menu 

D. All of the above 

ANSWER: A 

 

223. What is a pivot table in OpenOffice Calc? 

A. A type of chart 

B. A way to summarize and analyze data 

C. A formula for calculating values 

D. A database function 

ANSWER: B 

 

 

 

 

 

 

224. What is a slide master in OpenOffice 

Impress? 

A. A predefined layout for slides 

B. A type of chart 

C. A sound effect 

D. A transition effect 

ANSWER: A 

 

225. What is a transition effect in OpenOffice 

Impress? 

A. The animation effect between slides 

B. A type of chart 

C. A formula for calculating values 

D. A data validation rule 

ANSWER: A 

 

226. How do you start a slide show in 

OpenOffice Impress? 

A. Press the "F5" key 

B. Click the "Slide Show" button 

C. Use the "File" -> "Slide Show" menu 

D. All of the above 

ANSWER: D 

 

227. What is OpenOffice Draw primarily used 

for? 

A. Creating text documents 

B. Creating spreadsheets 

C. Creating presentations 

D. Creating diagrams and illustrations 

ANSWER: D 
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228. What is a table in OpenOffice Base? 

A. A collection of related data 

B. A type of chart 

C. A query 

D. A form 

ANSWER: A 

 

229. What is a query in OpenOffice Base? 

A. A request for specific data from a 

database 

B. A table 

C. A form 

D. A report 

ANSWER: A 

 

230. What is a form in OpenOffice Base? 

A. A user interface for entering and editing 

data 

B. A table 

C. A query 

D. A report 

ANSWER: A 

 

231. What is a report in OpenOffice Base? 

A. A formatted presentation of data 

B. A table 

C. A query 

D. A form 

ANSWER: A 

 

232. What is the NTFS file system? 

A. A file system developed by Apple 

B. A file system developed by Linux 

C. A file system developed by Microsoft 

D. A file system developed by Sony 

ANSWER: C 

233. What is the Event Viewer used for? 

A. Viewing system events and errors 

B. Managing hardware devices 

C. Creating system restore points 

D. Monitoring network activity 

ANSWER: A 

 

234. What is the purpose of the Event Viewer 

in troubleshooting computer problems? 

A. To identify potential causes of issues 

B. To fix problems automatically 

C. To prevent future problems 

D. To delete unnecessary files 

ANSWER: A 

 

235. How do you open the Device Manager in 

Windows? 

A. Right-click the Start button and select 

"Device Manager" 

B. Open the Control Panel and select 

"Device Manager" 

C. Both A and B 

D. None of the above 

ANSWER: C 

 

236. What is a logical drive? 

A. A physical division of a hard drive 

B. A logical division of a partition 

C. A file system format 

D. A type of file 

ANSWER: B 
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237. What is the purpose of disk cleanup? 

A. Deleting unnecessary files 

B. Combining fragmented files into 

contiguous blocks 

C. Creating a backup of the hard drive 

D. Checking for errors on the hard drive 

ANSWER: A 

 

238. What is a custom view in the Event 

Viewer? 

A. A predefined filter for events 

B. A user-defined filter for events 

C. A type of event log 

D. A way to clear event logs 

ANSWER: B 

 

239. What is the purpose of the Clear Event 

Log option? 

A. Deletes all events from a log 

B. Deletes events older than a specified date 

C. Deletes events from a specific source 

D. Deletes events with a specific event ID 

ANSWER: A 

 

240. What is the difference between an error 

event and a warning event? 

A. Error events indicate a critical problem, 

while warning events indicate a potential 

issue 

B. Error events are less severe than warning 

events 

C. There is no difference between the two 

D. Error events are always generated by 

hardware, while warning events are 

always generated by software 

ANSWER: A 

 

 

241. How can you save an event log for later 

analysis? 

A. By exporting it to a text file 

B. By copying and pasting the contents 

C. By saving it as a CSV file 

D. By printing the log 

ANSWER: A 

 

242. What is the purpose of the "Scan for 

hardware changes" option in the Device 

Manager? 

A. To detect newly installed or modified 

hardware 

B. To fix hardware problems 

C. To uninstall hardware 

D. To update device drivers 

ANSWER: A 

 

243. How can you troubleshoot a device 

problem using the Device Manager? 

A. Check for yellow exclamation marks 

B. Update device drivers 

C. Uninstall and reinstall the device 

D. All of the above 

ANSWER: D 

 

244. What is a keylogger? 

A. Software that records keystrokes 

B. A virus that infects executable files 

C. A type of antivirus software 

D. A hardware component 

ANSWER: A 
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245. What is a polymorphic virus? 

A. A virus that changes its code to avoid 

detection 

B. A virus that infects multiple files 

C. A type of antivirus software 

D. A hardware component 

ANSWER: A 

 

246. What is a social engineering attack? 

A. A type of malware 

B. A technique used to manipulate people 

into revealing personal information 

C. A hardware failure 

D. A network error 

ANSWER: B 

 

247. What is the purpose of software updates? 

A. To improve performance and security 

B. To increase hardware compatibility 

C. To reduce storage space 

D. To change the operating system 

ANSWER: A 

 

248. What should you do if your computer 

overheats? 

A. Ignore it 

B. Increase the fan speed 

C. Check for dust buildup and improve 

ventilation 

D. Overclock the CPU 

ANSWER: C 

 

 

 

 

 

249. What is the purpose of using surge 

protectors? 

A. To protect computer equipment from 

power surges 

B. To increase internet speed 

C. To improve computer performance 

D. To reduce noise 

ANSWER: A 

 

250. What is the importance of regular system 

scans for malware? 

A. To detect and remove malicious software 

B. To improve computer performance 

C. To increase storage space 

D. To change the operating system 

ANSWER: A 

 

251. What is crimping? 

A. The process of connecting wires to a 

connector 

B. The process of testing network cables 

C. The process of installing network devices 

D. The process of configuring network 

settings 

ANSWER: A 

 

252. What tools are used for crimping? 

A. Crimping tool and wire stripper 

B. Screwdriver and pliers 

C. Multimeter and cable tester 

D. None of the above 

ANSWER: A 
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253. What is a server? 

A. A computer that provides services to 

other computers 

B. A computer that requests services from 

other computers 

C. A software application 

D. A network device 

ANSWER: A 

 

254. What is a client? 

A. A computer that provides services to 

other computers 

B. A computer that requests services from 

other computers 

C. A software application 

D. A network device 

ANSWER: B 

 

255. What is the client-server model? 

A. A distributed computing model where 

clients request services from servers 

B. A centralized computing model 

C. A peer-to-peer computing model 

D. A cloud computing model 

ANSWER: A 

 

256. What is a database server? 

A. A computer that stores and manages 

databases 

B. A software application 

C. A network device 

D. A type of hardware 

ANSWER: A 

 

 

 

 

257. What is encryption? 

A. Converting data into a secret code 

B. Speeding up data transfer 

C. Compressing data 

D. Storing data 

ANSWER: A 

 

258. Types of malware is? 

A. Caterpillars 

B. Worms 

C. Lions 

D. Horses 

ANSWER:B 

 

259. Which one Not a linux distribution? 

A. debian 

B. gentoo 

C. open SUSE 

D. multicsr 

ANSWER:D 

 

260. _____are computer programs that are 

designed by attackers to gain root access to your 

computer 

A. Backdoors 

B. Rootkits 

C. Malware 

D. Spyware 

ANSWER:B 
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261. Antivirus software is an example 

of______ 

A. business software 

B. an operating system 

C. a security utility 

D. An office suite 

ANSWER:C 

 

262. Which of the following self-replicating 

software that causes damages to file and system? 

A. Viruses 

B. Trojan horses 

C. Bots 

D. Worms 

ANSWER:D 

 

263. The altering of data so that it is not usable 

unless the changes are undone is 

A. biometrics 

B. encryption 

C. ergonomics 

D. compression 

ANSWER:B 

 

264. __________are used in DOS 

attacks,against targeted web sites. 

A. Trojan horse 

B. Zombie 

C. Worm 

D. Virus 

ANSWER:B 

 

 

 

 

 

265. A strong password should contain these 

are 

A. Both uppercase and lowercase letters. 

B. A word that is easy to remember, such as 

the name of a pet. 

C. At least 8 characters, and a combination 

of letters, numbers, and characters. 

D. None of the mentioned 

ANSWER:C 

 

266. What is the first boot sector virus? 

A. Brain 

B. Mind 

C. ELK cloner 

D. None of the mentioned 

ANSWER:A 

 

267. Which of the following retains the 

information it's storing even when the power to 

the system is turned off? 

A. ALU 

B. ROM 

C. RAM 

D. DROM 

ANSWER:B 

 

268. Which one provide command interpreter 

environment? 

A. Kernel 

B. Shell 

C. CELL 

D. Hardware 

ANSWER:B 
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269. The taskbar located in the windows (by 

default) _________- 

A. On the start menu 

B. At the bottom of the screen 

C. On the quick launch toolbar 

D. at the top of the screen 

ANSWER:B 

 

270. Date and Time are available on the 

desktop at 

A. Key board 

B. recycle Bin 

C. My computer 

D. Task bar 

ANSWER:D 

 

271. The computer administrative tools is 

called 

A. Control panel 

B. Start button 

C. Internet explorer 

D. Recycle bin 

ANSWER:A 

 

272. Elements is used to manage files & 

folders is 

A. Control panel 

B. Windows 

C. Window explorer 

D. Internet explorer 

ANSWER:C 

 

 

 

 

 

273. Pressing and releasing the left mouse 

button quickly is called______ 

A. clicking 

B. dropping 

C. pointing 

D. dragging 

ANSWER:A 

 

274. Graphics Application in windows named 

is________ 

A. Brush 

B. Notepad 

C. paint 

D. Fill 

ANSWER:C 

 

275. The distance between lines in a paragraph 

is called_________. 

A. Spacing 

B. Word Spacing 

C. Line Spacing 

D. Row Spacing 

ANSWER:C 

 

276. Which of the following is an example of 

open source software? 

A. Adobe Photoshop 

B. Microsoft Word 

C. Libre Office 

D. Skype 

ANSWER:C 
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277. Shortcut key used in Word select 

everything 

A. Ctrl+S 

B. Ctrl+Alt+Delete 

C. Ctrl+N 

D. Ctrl+A 

ANSWER:D 

 

278. Watermark uses of word document 

is______ 

A. Text 

B. Image 

C. Both A & B 

D. None of the mentioned 

ANSWER:C 

 

279. Which item is printed at the TOP of each 

page 

A. Header 

B. Foot Note 

C. Title 

D. Footer 

ANSWER:A 

 

280. _____________ is a type of tweezer. 

A. Diamond point 

B. Pointed slant 

C. Flathead 

D. Torx 

ANSWER: B 

 

 

 

 

 

 

281. Which of the following is NOT a type of 

pliers. 

A. Electronic 

B. Pump 

C. Flush cutter 

D. Square 

ANSWER: D 

 

282. A computer program which is designed to 

help people perform an activity using the 

computer. 

A. Internet 

B. Application 

C. Hardware 

D. Software 

ANSWER: B 

 

283. In a computer, ALU can perform 

A. Addition 

B. Subtraction 

C. Multiplication 

D. All of the mentioned 

ANSWER: D 

 

284. Combination of Arithmetic Logic Unit 

and Control Unit results in a 

A. Arithmetic Control Unit 

B. Control Processing Unit 

C. Central Processing Unit 

D. Central Control Logic Unit 

ANSWER: C 
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285. All the parts of the computers are 

connected to this part and this allows all the part 

of the computer to work together 

A. Operating System 

B. Disk Drive 

C. Output Device 

D. Motherboard 

ANSWER: D 

 

286. Default pointing device in a laptop is 

called 

A. Mouse 

B. Keyboard 

C. Touchpad 

D. Tap-pad 

ANSWER: C 

 

287. This part stores programs and other 

information on 2 or more disks that are located 

inside the computer 

A. Motherboard 

B. Hard drive 

C. CPU 

D. Operating System 

ANSWER: B 

 

288. ________ keys are present on the top row 

of the keyboard. 

A. Function 

B. Typewriter 

C. Numeric 

D. Navigation 

ANSWER: A 

 

 

 

 

289. Which of the following should be used to 

extinguish a computer fire? 

A. Fire hose 

B. Class A extinguisher 

C. Class C extinguisher 

D. Silver Foam Water 

ANSWER: C 

 

290. If the boot-up process of a PC halts and 

the message - “Non-System disk or disk error.... 

Replace and press any key when ready” appears, 

the problem might be 

A. A non-bootable CD is in the CD-Drive 

and you should remove it 

B. The hard drive has failed and you should 

replace it 

C. RAM has failed and you should remove it 

D. A key on the keyboard is stuck and you 

should replace the keyboard 

ANSWER: A 

 

291. Installation of software in a computer 

means 

A. only copying the software in the 

computer 

B. making the software ready for execution 

C. downloading the software from the 

internet 

D. running a drive containing the software 

ANSWER: B 

 

292. What part of the computer can be used on 

its own? 

A. Hardware 

B. Software 

C. Firmware 

D. None of the mentioned 

ANSWER: D 
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293. If a program is being executed, we call it 

a ___________ 

A. Task 

B. Instance 

C. Instruction 

D. Process 

ANSWER: D 

 

294. Choose the correct statement from the 

following. 

A. Software is a collection of programs 

B. A program is a collection of software 

C. There is no relation between software and 

program 

D. Software becomes a program after 

installation 

ANSWER: A 

 

295. What beep codes may indicate a system 

board or power supply failure? 

A. No beep 

B. Continuous beep 

C. Steady long beeps 

D. All of the mentioned 

ANSWER: D 

 

296. What are physical ports on a computer 

usually referred to as? 

A. Buses 

B. Jacks 

C. Interfaces 

D. Hardware plugs 

ANSWER: C 

 

 

 

 

297. Which of the following can be transferred 

over HDMI cable? 

A. Video 

B. Sound 

C. Video and Sound 

D. Neither Video nor Sound 

ANSWER: C 

 

298. Which type of connector is mostly used 

these days to connect to network cards? 

A. BNC 

B. 6 pin 

C. RJ-11 

D. RJ-45 

ANSWER: D 

 

299. From the following choose the option 

which is NOT system software. 

A. MS Office 

B. Language translator 

C. Navigator 

D. Utility 

ANSWER: A 

 

300. Who takes care of running and loading 

programs by use of peripherals? 

A. Operating System 

B. Control System 

C. Dump programs 

D. Function System 

ANSWER: A 

 

301. Uninstalling an application can be done 

only by removing the program folder. 

A. True 

B. False 

ANSWER: B 
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302. Some software in linux is assembled 

using other programs in order to use.this is called: 

A. Creating 

B. Initiating 

C. Compiling 

D. Programming 

ANSWER: C 

 

303. Linux has configuration files stored in 

one folder.What is the folder name? 

A. etc 

B. var 

C. bin 

D. home 

ANSWER: A 

 

304. Evaluates the bash order of evalution to 

determine the first instance to the given command 

A. type 

B. which-a 

C. which 

D. hash 

ANSWER: A 

 

305. Which will return a value of 9: 

A. echo $[[4+5]] 

B. echo $((4+5)) 

C. echo [4+5] 

D. echo "4+5" 

ANSWER: B 

 

 

 

 

 

 

306. Syntax used to get the following 

permissions -rwxrw-rw- 

A. chmod 744 

B. chmod 766 

C. chmod 777 

D. chmod 754 

ANSWER: B 

 

307. Which program provides user access to 

delete files in Windows OS? 

A. Window Manager 

B. Window Explorer 

C. Internet Explorer 

D. Start Menu 

ANSWER: B 

 

308. Window task bar shows which programs 

are currently running on the computer 

A. True 

B. False 

ANSWER: A 

 

309. Adding new peripherals(hardware) to 

your computer often requires what software to 

allow Windows to communicate with the new 

hardware? 

A. Application Software 

B. Driver 

C. Passenger 

D. Installers 

ANSWER: B 
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310. What program shows the user how much 

free space remains on their hard drive? 

A. Window Explorer 

B. Window Manager 

C. Internet Explorer 

D. Task Managment 

ANSWER: A 

 

311. Windows displays three icons on the top 

right window of an application.The icon appear in 

the form of a dash,square, and an x.What function 

below occurs after clicking the square? 

A. Program is Maximized 

B. Program is Minimized 

C. Program is deleted 

D. Program reboots 

ANSWER: A 

 

312. Which of the following is NOT a type of 

a screwdriver? 

A. Slotted 

B. Phillips 

C. Hex 

D. Diamond 

ANSWER: D 

 

313. Wire strippers remove what from wires? 

A. Magnetism 

B. Excess wire 

C. Insulation 

D. Oil 

ANSWER: C 

 

 

 

 

 

314. TPI stands for 

A. Tongs passing increments 

B. Triangle penetrating increments 

C. Teeth per inch 

D. Tangible penetrating instruments 

ANSWER: C 

 

315. Which of the following is NOT a trait of 

modern computers 

A. Speed 

B. Accuracy 

C. Intelligence 

D. Reliability 

ANSWER: C 

 

316. Which of the following is the best way to 

prevent damaging your PC from static electricity? 

A. Wear an Electrostatic Discharge(ESD) 

wrist strap 

B. Wear leather or rubber-soled shoes 

C. Periodically touch a safe ground spot on 

the PC to discharge yourself 

D. Place your PC on a rubber mat 

ANSWER: A 

 

317. Choose the correct pair from the 

following. 

A. Application Software - Low-Level 

Software 

B. System Software - High-Level Software 

C. System Software - Low-Level Software 

D. Middleware - High-Level Software 

ANSWER: C 
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318. Firewall is__________ 

A. A program that protects against viruses. 

B. A wall that is reinforced and cannot catch 

on fire. 

C. A filter for an internet connection that 

monitors outgoing and incoming activity. 

D. None of the mentioned 

ANSWER:C 

 

319. Which among the following is the fastest 

memory in a computer that holds information? 

A. Register 

B. Cache 

C. Main memory 

D. RAM 

ANSWER: A 

 

320. Which of the following are the 

predominant manufacturers for desktop and 

laptop processors? 

A. Intel 

B. AMD (Advanced Micro Devices) 

C. Motorola 

D. Both A and B 

ANSWER: D 

 

321. Which bus is used to carry data to and 

from the memory? 

A. Address bus 

B. Data bus 

C. Control bus 

D. None of these 

ANSWER: B 

 

 

 

 

322. Computer gets the input with the help of 

A. mouse and keyboard 

B. joystick 

C. printer 

D. both a and b 

ANSWER: D 

 

323. Which of the following are not input 

devices? 

A. Keyboard, trackball, light pen 

B. Barcode reader, OMR, OCR, MICR 

C. Biometric sensor, scanner, Mic 

D. Plotter, projector, headphones 

ANSWER: D 

 

324. CPU is fabricated on a single integrated 

circuit board that is known as 

A. Motherboard 

B. Microprocessor 

C. CU 

D. ALU 

ANSWER: B 

 

325. Monitor is connected to a computer using 

______ port. 

A. RS232/ serial 

B. PS/2 

C. VGA (Video Graphics Array) 

D. LPT (Line printer Terminal) 

ANSWER: C 
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326. On a dot matrix printer, you should never 

lubricate which part? 

A. carriage rails                                 

B. printhead pins 

C. paper advance bearings                        

D. carriage bearings 

ANSWER: B 

 

327. Which provides the fastest data access 

time? 

A. RAM                       

B. ROM 

C. CD-ROM               

D. Hard disk 

ANSWER: A 

 

328. What is the first thing you could do to 

check for damage to a printer after receiving it? 

A. Run MSD diagnostics                

B. Attach it to a PC and print something 

C. Check the cables                         

D. Unbox it and examine it for physical 

damage 

ANSWER: D 

 

329. Files are maintain in which hierachical 

structure? 

A. Descriptors 

B. Directories 

C. Modifiers 

D. Relative Files 

ANSWER:B 

 

 

 

 

 

330. Secondary storage of a computer 

performs______operation 

A. Volatile 

B. Non-volatile 

C. Complex 

D. Non-circuit 

ANSWER:B 

 

331. The most common buses inside the 

microcomputer are 

A. Address bus 

B. Address bus and Data bus 

C. Address bus and Control bus 

D. Address bus, Data bus, and Control bus 

ANSWER: D 

 

332. Which command creates an empty file if 

file does not exist? 

A. cat 

B. touch 

C. ed 

D. read 

ANSWER: B 

 

333. A driver conflict occurs when: 

A. Two or more drivers are incompatible 

B. The operating system is corrupted 

C. The hardware is faulty 

D. The software is outdated 

ANSWER: A 
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334. A rollback is used to: 

A. Restore a system to a previous state 

B. Upgrade the operating system 

C. Install new software 

D. Increase system performance 

ANSWER: A 

 

335. It's generally recommended to create a 

system restore point before: 

A. Installing new hardware 

B. Installing new software 

C. Making significant system changes 

D. All of the above 

ANSWER: D 

 

336. What is the difference between a major 

and minor software update? 

A. Major updates add new features, while 

minor updates fix bugs and improve 

performance. 

B. Major updates are paid, while minor 

updates are free. 

C. Major updates require a complete 

reinstallation, while minor updates do 

not. 

D. There is no difference between the two. 

ANSWER: A 

 

337. What is a slide master in PowerPoint? 

A. A predefined layout for slides 

B. A special type of chart 

C. A sound effect 

D. A transition effect 

ANSWER: A 

 

 

 

338. What is a database relationship? 

A. A connection between two tables based 

on a common field 

B. A formula for calculating values 

C. A chart type 

D. A report format 

ANSWER: A 

 

339. What is a file permission in Linux? 

A. Controls who can access and modify a 

file 

B. Determines the file size 

C. Specifies the file type 

D. Indicates the file creation date 

ANSWER: A 

 

340. What is a process ID (PID)? 

A. A unique identifier for a running process 

B. A file permission 

C. A network port number 

D. A hardware address 

ANSWER: A 

 

341. What is a user group in Linux? 

A. A collection of users with similar 

privileges 

B. A physical group of people 

C. A software application 

D. A hardware component 

ANSWER: A 

 

 

 

 

 

 



Page | 42 

 

 

 

 

 

342. What is a soft link in Linux? 

A. A physical copy of a file 

B. A pointer to another file 

C. A type of hardware device 

D. A network protocol 

ANSWER: B 

 

343. What is the purpose of the "exit" 

command in a shell script? 

A. To terminate the script execution 

B. To display a message 

C. To perform arithmetic operations 

D. To create a loop 

ANSWER: A 

 

344. What is the purpose of the "trap" 

command in a shell script? 

A. To handle signals and errors 

B. To create functions 

C. To perform arithmetic operations 

D. To control the flow of the script 

ANSWER: A 

 

345. What is the purpose of the "shift" 

command in a shell script? 

A. To shift the positional parameters 

B. To change the working directory 

C. To create a function 

D. To exit the script 

ANSWER: A 

 

 

 

 

 

 

346. What is the purpose of the "getopts" 

command in a shell script? 

A. To parse command-line arguments 

B. To create functions 

C. To handle signals 

D. To perform arithmetic operations 

ANSWER: A 

 

347. What is the purpose of the "awk" 

command in a shell script? 

A. Text processing and pattern matching 

B. Creating files 

C. Modifying file permissions 

D. Changing file ownership 

ANSWER: A 

 

348. What is the purpose of the "sed" 

command in a shell script? 

A. Stream editor for filtering and 

transforming text 

B. Creating files 

C. Modifying file permissions 

D. Changing file ownership 

ANSWER: A 

 

349. What is the purpose of the "test" 

command or the square brackets [ ] in a shell 

script? 

A. To perform arithmetic operations 

B. To create functions 

C. To test conditions and make decisions 

D. To handle signals 

ANSWER: C 
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350. What is the difference between single 

quotes and double quotes in a shell script? 

A. Single quotes treat all characters literally, 

while double quotes allow variable 

expansion 

B. Single quotes allow variable expansion, 

while double quotes treat all characters 

literally 

C. There is no difference between single 

quotes and double quotes 

D. Single quotes are used for strings, double 

quotes for numbers 

ANSWER: A 

 

351. What is the purpose of the "here 

document" (<<) in a shell script? 

A. To redirect output to a file 

B. To create a multi-line string 

C. To define a function 

D. To handle signals 

ANSWER: B 

 

352. What is an absolute cell reference in 

OpenOffice Calc? 

A. A cell reference that changes when a 

formula is copied 

B. A cell reference that remains constant 

when a formula is copied 

C. A type of chart 

D. A data validation rule 

ANSWER: B 

 

 

 

 

 

 

 

 

353. What is a relative cell reference in 

OpenOffice Calc? 

A. A cell reference that changes when a 

formula is copied 

B. A cell reference that remains constant 

when a formula is copied 

C. A type of chart 

D. A data validation rule 

ANSWER: A 

 

354. What are the three main types of logs in 

the Event Viewer? 

A. System, Application, and Security 

B. Error, Warning, and Information 

C. Critical, Error, and Warning 

D. Debug, Information, and Verbose 

ANSWER: A 

 

355. What is a hidden device in the Device 

Manager? 

A. A device that is physically broken 

B. A device that is not currently installed 

C. A device that is not visible by default 

D. A device that is malfunctioning 

ANSWER: C 

 

356. Which security feature prevents a user 

from accessing websites that may contain 

malware or inappropriate content? 

A. Content Filtering 

B. Encryption 

C. Authentication 

D. Hashing 

ANSWER: A 
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357. What is latency? 

A. The time taken for a data packet to travel 

from one point to another 

B. The error rate of a communication 

channel 

C. Amount of data that can be transmitted 

over a communication channel in a given 

amount of time 

D. The type of network topology 

ANSWER: A 

 

358. How can you filter events in the Event 

Viewer? 

A. By event type, source, and date 

B. By user account only 

C. By event description only 

D. By event ID only 

ANSWER: A 

 

359. What are the two types of firewalls? 

A. Internal and external 

B. Hardware and software 

C. Public and private 

D. Static and dynamic 

ANSWER: B 

 

360. What does a red exclamation mark icon 

next to an event typically indicate? 

A. A successful event 

B. A warning event 

C. An error event 

D. An informational event 

ANSWER: C 

 

 

 

 

361. How do we comment in shell script? 

A. # 

B. /* */ 

C. ' 

D. // 

ANSWER: A 

 

362. cd command in Linux is used for; 

A. Change directory 

B. Copy dictionary 

C. Create directory 

D. Delete directory 

ANSWER: A 

 

363. What does the "cat" command do in 

Linux? 

A. Create a file 

B. Append text to a file 

C. Display the contents of a file 

D. Delete a file 

ANSWER: C 

 

364. The default file extension for a 

presentation created in OpenOffice Impress is 

A. .pptx 

B. .ppt 

C. .odp 

D. .pdf 

ANSWER: C 

 

365. What is the Device Manager used for? 

A. Managing files and folders 

B. Managing hardware devices 

C. Managing system processes 

D. Managing network connections 

ANSWER: B 
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366. What is disk defragmentation? 

A. Deleting unnecessary files 

B. Combining fragmented files into 

contiguous blocks 

C. Creating a backup of the hard drive 

D. Checking for errors on the hard drive 

ANSWER: B 

 

367. What is the function of "chown" 

command in Linux? 

A. Change file owner 

B. Change file permissions 

C. Change file group 

D. Change file name 

ANSWER: A 

 

368. Why do we use single quotes and double 

quotes in a shell script? 

A. Single quotes treat all characters literally, 

while double quotes allow variable 

expansion 

B. Single quotes allow variable expansion, 

while double quotes treat all characters 

literally 

C. There is no difference between single 

quotes and double quotes 

D. Single quotes are used for strings, double 

quotes for numbers 

ANSWER: A 

 

369. A thermal paste is used to: 

A. Improve CPU performance 

B. Conduct electricity 

C. Improve heat transfer between CPU and 

heatsink 

D. Reduce noise 

ANSWER: C 

 

 

370. CPU serves the purpose of: 

A. Storing data 

B. Inputting data 

C. Outputting data 

D. Processing data 

ANSWER: D 

 

371. Who can be said to be a  hacker? 

A. Someone who breaks into computer 

systems 

B. A hardware technician 

C. A computer programmer 

D. A network administrator 

ANSWER: A 

 

372. What is preventive maintenance? 

A. Repairing a computer after it breaks down 

B. Regularly inspecting and maintaining 

computer hardware 

C. Upgrading computer components 

D. Installing new software 

ANSWER: B 

 

373. Which type of memory is non-volatile 

and retains data though the power is off? 

A. Cache 

B. Register 

C. ROM 

D. RAM 

ANSWER: C 
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374. Cable management is important for: 

A. Better aesthetics 

B. Reducing noise 

C. Improving airflow 

D. All of these 

ANSWER: D 

 

375. Disk Management is primarily used for 

A. Managing files and folders 

B. Managing hardware devices 

C. Managing system processes 

D. Managing network connections 

ANSWER: A 

 

376. A power supply unit (PSU) converts: 

A. DC power to AC power 

B. Data to information 

C. AC power to DC power 

D. Digital signals to analog signals 

ANSWER: C 

 

377. When removing a CPU cooler, it's 

important to: 

A. Remove the motherboard first 

B. Avoid touching the CPU core 

C. Use excessive force 

D. Apply pressure evenly 

ANSWER: B 

 

378. A software license grants: 

A. The right to modify the software 

B. Permission to use the software 

C. Ownership of the software 

D. All of these 

ANSWER: B 

379. Which component stores the BIOS? 

A. ROM 

B. HDD 

C. SSD 

D. RAM 

ANSWER: A 

 

380. Which unit is used to measure the speed 

of CPU: 

A. Hertz 

B. Bytes 

C. Bits 

D. Watts 

ANSWER: A 

 

381. What is a CLI? 

A. A graphical interface for interacting with 

a computer 

B. A text-based interface for interacting with 

a computer 

C. A programming language 

D. A type of hardware 

ANSWER: B 

 

382. A beta version of software is: 

A. The final, released version 

B. A preliminary version for testing 

C. A type of malware 

D. An open-source software 

ANSWER: B 
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383. What is bandwidth? 

A. The amount of data that can be 

transmitted over a communication 

channel in a given amount of time 

B. The distance between two points on a 

network 

C. The number of devices connected to a 

network 

D. The type of network topology 

ANSWER: A 

 

384. The clock speed of a CPU determines: 

A. The amount of data it can process 

B. The speed at which it can execute 

instructions 

C. The amount of memory it can access 

D. The size of the CPU 

ANSWER: B 

 

385. What is the purpose of the "case" 

statement in a shell script? 

A. To perform conditional execution based 

on multiple conditions 

B. To create loops 

C. To define functions 

D. To manipulate variables 

ANSWER: A 

 

386. Copying a process from memory to disk 

to allow space for other processes is 

A. Swapping 

B. Deadlock 

C. Demand Paging 

D. Page Fault 

ANSWER:A 

 

 

 

387. Which is not a System tool? 

A. Files 

B. Backup 

C. Scandisk 

D. Format 

ANSWER:A 

 

388. Dir/W is 

A. Show all details of file 

B. Show only file name and directory name 

C. Shows only directory 

D. All of the mentioned 

ANSWER:B 

 

389. Valid permission in the linux system 

is_________ 

A. Write 

B. Half control 

C. Modify 

D. Change 

ANSWER:A 

 

390. FAT Stands for 

A. File Accomodation Table 

B. File Access Tape 

C. File Allocation Table 

D. File Activity Table 

ANSWER:C 

 

391. Which of the following directory contains 

configuration files? 

A. /dev/ 

B. /etc/ 

C. /bin/ 

D. /root/ 

ANSWER:B 
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392. Which command will show the 

configuration details of a wireless connection in 

Linux? 

A. grep 

B. ipconfig 

C. iwconfig 

D. ifconfig 

ANSWER: C 

 

393. What type of file system is used in most 

modern Linux Operating Systems? 

A. FAT32 

B. FAT16 

C. NTFS 

D. EXT4 

ANSWER: D 

 

394. What is the difference between touch and 

cat command? 

A. cat command is used to create the file 

with content whereas touch command is 

used to create a file without any content. 

B. touch command is used to create the file 

with content whereas cat command is 

used to create a file without any content. 

C. cat command is used to create the folder 

with content whereas touch command is 

used to create a folder without any 

content. 

D. touch command is used to create the file 

with content whereas cat command is 

used to create a folder without any 

content. 

ANSWER: A 

 

 

 

 

 

 

395. Which command on Debian/ubuntu based 

Linux platform gives root permissions for other 

commands? 

A. sudo 

B. grep 

C. aptitude 

D. apt-get 

ANSWER: A 

 

396. The operations of the arithmetic unit and 

the control unit in a computer are controlled by 

A. ALU itself 

B. Control Unit itself 

C. Applications 

D. Memory Unit 

ANSWER: B 

 

397. The programs and data currently being 

processed by CPU is stored in 

A. Mass Memory 

B. RAM 

C. PROM 

D. Non-volatile Memory 

ANSWER: B 

 

398. Which of the following controls the 

process of interaction between the user and the 

computer? 

A. User interface 

B. Screensaver 

C. Platform 

D. Language translator 

ANSWER: A 

 

 

 

 



Page | 49 

 

 

 

 

 

399. What characteristic of read-only memory 

(ROM) makes it useful? 

A. ROM information can be easily updated. 

B. Data in ROM is non-volatile, that is, it 

remains there even without electrical 

power. 

C. ROM provides very large amounts of 

inexpensive data storage. 

D. ROM chips are easily swapped between 

different brands of computers 

ANSWER: B 

 

400. A light-sensitive device that converts 

drawing, printed text or other images into digital 

form is 

A. Keyboard 

B. Scanner 

C. Plotter 

D. OMR 

ANSWER: B 

 

401. Which of the following groups consists of 

only input devices? 

A. Mouse, Keyboard, Monitor 

B. Mouse, Scanner, Printer 

C. Joystick, Keyboard, Plotter 

D. Mouse, Keyboard, Scanner 

ANSWER: D 

 

402. What is GPF? 

A. A hard drive with insufficient space 

B. Part of the Microsoft General Procedures 

Windows Format toolkit 

C. A Windows General Protection Fault 

D. None of the mentioned 

ANSWER: C 

 

 

403. If the Windows system resources drop 

below 60%, the system is likely to 

A. Overheat 

B. Crash 

C. Run optimally if it has an Intel chip 

D. Anti-virus systems start running 

ANSWER: B 

 

404. How do you know the right direction of 

plugging in an unscreened flat ribbon cable into a 

connector? 

A. The red line in the cable goes to the 

highest pin number 

B. The colored line in the cable goes to the 

first pin 

C. The colored line in the cable goes to the 

last pin 

D. It can be connected in any way. 

ANSWER: B 

 

405. What should be the first action when 

Windows reports that your hard drive is 

developing bad sectors? 

A. Replace the hard drive 

B. Run secclean from DOS 

C. Run defrag on the hard drive 

D. Run Scandisk with the thorough option 

ANSWER: D 

 

406. To test the serial and parallel ports on 

your computer, which of the following tools 

might be used? 

A. High Volt probe 

B. Cable Scanner 

C. Oscilloscope 

D. Loopbacks (Wrap Plugs) 

ANSWER: D 
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407. How can the CMOS be cleared, including 

the password? 

A. Unplug the PC 

B. Unplug the PC and remove the CMOS 

battery 

C. Run a CMOS command from the 

command line 

D. It is not possible 

ANSWER: B 

 

408. What could result in a fixed disk error? 

A. No CD-Drive installed 

B. Bad RAM 

C. Incorrect CMOS settings 

D. Bad ROM 

ANSWER: C 

 

409. What is the bus architecture used by 

SATA cables? 

A. Parallel 

B. Serial 

C. Depends on the chipset used 

D. Multiplexed 

ANSWER: B 

 

410. How many pins does a PS/2 connector 

have? 

A. 5 

B. 9 

C. 12 

D. 6 

ANSWER: D 

 

 

 

 

 

411. How many pins are there in the USB-C 

Connector? 

A. 12 

B. 24 

C. 16 

D. 20 

ANSWER: B 

 

412. The software can be installed on a 

computer by 

(i) Simply copying the software into a folder 

on the computer 

(ii) Running an installation procedure to 

make the software executable 

A. Only (i) 

B. Only (ii) 

C. Neither (i) nor (ii) 

D. Both (i) and (ii) 

ANSWER: D 

 

413. The supermarket near your house has 

installed a new inventory management system. 

What type of software is that? 

A. Operating System 

B. Communications Software 

C. System Software 

D. Database Software 

ANSWER: D 
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414. Select the correct statement about 

application software 

(i) First, the user deals with system software 

and then deals with application software. 

(ii) It is programmed for simple as well as 

complex tasks. 

(iii) It can only be installed on a computer. 

(iv) It can be a single program or a group of 

small programs that are referred to as an 

application suite. 

A. All the above statements are correct 

B. Only (i), (ii), and (iv) 

C. Only (i), (ii), and (iii) 

D. Only (i) and (ii) 

ANSWER: B 

 

415. Which of the following is NOT a function 

performed by application software? 

A. Managing Information 

B. Manipulating Data 

C. Calculating figures 

D. Memory Management 

ANSWER: D 

 

416. Which command is used to view 

processes running in the background in linux? 

A. ls 

B. bg 

C. jobs 

D. dmsg 

ANSWER:C 

 

 

 

 

 

 

417. Which command are using view Hidden 

files? 

A. ls -a 

B. ls -l 

C. ls -h 

D. Is -k 

ANSWER:A 

 

418. Which command is used to change 

password of linux system? 

A. password 

B. pass 

C. change -p 

D. passwd 

ANSWER:D 

 

419. Which of the following command is used 

to print the login shell of an user? 

A. echo $SHELL 

B. echo $LSHELL 

C. echo $LOGIN 

D. None of the mentioned 

ANSWER:A 

 

420. Which of the following command is used 

delete the directory? 

A. Deltree/f 

B. Erase *.* 

C. Deltree *.* 

D. Del *.*/p 

ANSWER: C 
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421. We can change the thickness of a line 

from _______ 

A. Line width 

B. Line Height 

C. Line Thick 

D. Line Style 

ANSWER:D 

 

422. Color and pattern used to fill a closed 

shape is called___________ 

A. Shapes 

B. Word 

C. Fill Style 

D. Fill Back 

ANSWER: C 

 

423. Which of the following is program 

group? 

A. Accessories 

B. paint 

C. Word 

D. All the mentioned 

ANSWER:A 

 

424. Maximum number of lines you can set for 

a drop cap in Word? 

A. 15 

B. 20 

C. 10 

D. Undefined 

ANSWER:C 

 

 

 

 

 

425. Open office writer is not compatible with 

these extension? 

A. txt 

B. doc 

C. sxw 

D. csv 

ANSWER:D 

 

426. List of files are waiting to be printed on 

printer is called 

A. print list 

B. print stack 

C. print queue 

D. print line 

ANSWER:C 

 

427. Zip files are_________ 

A. Compressed Files 

B. Fragmented File 

C. Deleted Files 

D. Save Files 

ANSWER:A 

 

428. All device files are stored in which 

directory in Linux 

A. /dev 

B. /usr 

C. /etc 

D. None of the mentioned 

ANSWER: A 
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429. Home directory represented by a _______ 

symbol. 

A. # 

B. ~ 

C. ! 

D. $ 

ANSWER:B 

 

430. Which of the command will be used to 

delete all the files from the current directory ? 

A. rm ? 

B. rm ?* 

C. rm [*1 

D. rm * 

ANSWER:D 

 

431. Which module gives control of the CPU 

to the process selected by the short-term 

scheduler? 

A. dispatcher 

B. interrupt 

C. schedule 

D. None of the mentioned 

ANSWER:A 

 

432. Maintaining the security of important 

data is known as 

A. data backup 

B. data protection 

C. data locking 

D. data securing 

ANSWER: B 

 

 

 

 

 

433. which of the following attacks firewall 

protects is? 

A. Phishing 

B. Dumpster diving 

C. Denial of Service (DoS) 

D. Shoulder surfing 

ANSWER:C 

 

434. Not a reason why people create a 

computer virus ? 

A. Protection 

B. Identity theft 

C. Pranks 

D. Research purpose 

ANSWER:A 

 

435. How to set the environmental variable in 

Linux? 

A. grep i NAME=VALUE 

B. grep NAME=VALUE 

C. export NAME=VALUE 

D. env NAME=VALUE 

ANSWER: C 

 

436. If you want to execute the file name 

demo.sh in linux, what command will you use ? 

A. chmod -x sh demo 

B. chmod +x demo.sh 

C. chmod sh demo.sh 

D. chmod +x sh demo 

ANSWER: B 
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437. When is it mandatory to use a antivirus 

on linux machine? 

A. While updating the softwares in linux 

B. For Upgrading linux versions 

C. When running linux based 

fileserver/mailserver 

D. While executing the linux commands in 

shell 

ANSWER: C 

 

438. How to find a word hello in a 

welcome.txt file using linux command? 

A. grep welcome.txt find "hello" 

B. grep "hello" welcome.txt 

C. grep --find "hello" welcome.txt 

D. find "hello" welcome.txt 

ANSWER: B 

 

439. What is the period character of the hidden 

file ssh in linux? 

A. .ssh 

B. _ssh 

C. ssh. 

D. All of the mentioned 

ANSWER: A 

 

440. What is the following command used to 

check the IP Address of the machine using 

command prompt? 

A. ipcheck 

B. ipaddress 

C. ipaddr 

D. ipconfig 

ANSWER: D 

 

 

 

441. How to check how long the windows 

machine was running in windows machine? 

A. System time in Administration Tab 

B. System up time in Administration Tab 

C. System wakeup time in Performance Tab 

D. System up time in Performance Tab 

ANSWER: D 

 

442. Which of the following statement is 

correct in windows? 

A. MSI is used only with installers 

B. MSI files cannot be used with installers 

C. MSI & EXE can be executed with 

installers 

D. Something else 

ANSWER: C 

 

443. ______ command is used to check the 

connection between a local computer and other 

computer device? 

A. check 

B. ping 

C. connect 

D. search 

ANSWER: B 

 

444. Which register holds the actual 

instruction being executed currently by the 

computer? 

A. Memory address register (MIR) 

B. Instruction register (IR) 

C. Memory data register (MDR) 

D. Program counter register 

ANSWER: B 
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445. Which register holds the address of the 

current instruction being executed? 

A. Instruction register 

B. Memory data register (MDR) 

C. Stack register 

D. Program counter 

ANSWER: D 

 

446. Which register holds the address of a 

memory location? 

A. Memory data register 

B. Memory address register 

C. Status register 

D. Stack address 

ANSWER: B 

 

447. Which register shows the results of 

arithmetic and logical operations such as carry, 

overflow, negative? 

A. Stack register 

B. Status register 

C. Memory data register 

D. Memory buffer 

ANSWER: B 

 

448. Which of the following register holds a 

data value that is being stored to or retrieved from 

the memory location? 

A. PSW 

B. Main memory 

C. Memory data register 

D. Cache register 

ANSWER: C 

 

 

 

 

449. A device that allows entering data and 

instruction into a computer system is called 

A. interaction 

B. terminal 

C. communication 

D. input 

ANSWER: D 

 

450. Which of the keys are also known as 

modifier keys? 

A. Shift 

B. Ctrl 

C. Alt 

D. All the above 

ANSWER: D 

 

451. Which keys are also known as toggle 

keys? 

A. Caps lock, Num lock 

B. Control key, Enter key 

C. Shift, Esc 

D. Both a and b 

ANSWER: A 

 

452. Which key is used to indent a paragraph? 

A. Spacebar 

B. Tab 

C. Shift 

D. None 

ANSWER: B 
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453. Which key is used to open the Start 

menu? 

A. Windows 

B. Alt 

C. Ctrl + Alt 

D. None of these 

ANSWER: A 

 

454. Which key is used to erase data from the 

computer’s memory and characters on the screen? 

A. Backspace 

B. Delete 

C. Shift + Alt 

D. Both A and B 

ANSWER: B 

 

455. Which bus is used to connect external 

devices? 

A. Address 

B. Data 

C. Control 

D. External 

ANSWER: D 

 

456. Which of the following is not an integral 

part of the computer system? 

A. CPU 

B. Mouse 

C. Monitor 

D. UPS 

ANSWER: D 

 

 

 

 

 

457. Which of the following device provides 

surge protection and battery backup power during 

a power outage? 

A. Battery strip 

B. Surge strip 

C. UPS 

D. USB 

ANSWER: C 

 

458. Which of the following is a temporary 

storage location attached to CPU for input and 

output operations? 

A. Memory chip 

B. Register 

C. Buffer 

D. Core 

ANSWER: C 

 

459. Which of the following is used to 

measure the speed of the CPU (processor)? 

A. Processing speed 

B. Unit 

C. Coprocessor 

D. Clock speed 

ANSWER: D 

 

460. A uniform interval of CPU time allocated 

for performing a task is called 

A. real time 

B. seek time 

C. time slice 

D. unit time 

ANSWER: C 
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461. What is the full form of DMA? 

A. Direct memory access 

B. Dynamic memory access 

C. Double memory access 

D. None of these 

ANSWER: A 

 

462. Internal memory of central processing 

unit is nothing but 

A. a set of registers 

B. a set of ALU and CU 

C. buses 

D. None 

ANSWER: A 

 

463. Which memory is used for storing data 

and program instructions currently being executed 

by CPU? 

A. Mass memory 

B. Auxiliary memory 

C. Internal memory 

D. Non-volatile memory 

ANSWER: C 

 

464. Which of the following key should be 

pressed to move to the beginning of a line of text? 

A. Page up 

B. Shift 

C. Home 

D. Enter 

ANSWER: C 

 

 

 

 

 

465. Most PCs give a single beep on bootup to 

indicate they are ok hardware wise. You boot 

your PC and don’t get a beep. What should you 

check first? 

A. system board                    

B. RAM 

C. microprocessor                 

D. speaker 

ANSWER: D 

 

466. _____ is the term used to refer to the 

process of two modems establishing 

communications with each other. 

A. interacting 

B. handshaking 

C. connecting 

D. linking 

ANSWER: B 

 

467. The opening provided in the front panel 

or rear panel of a CPU for connecting peripherals 

is called _____. 

A. socket        

B. pin 

C. port             

D. part 

ANSWER: C 

 

468. External dialup MODEM can be 

connected to a computer using ______ port. 

A. RS232/ serial 

B. PS/2 

C. VGA 

D. LPT 

ANSWER: A 
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469. Home Key helps of 

A. Moves the cursor beginning of the 

document 

B. Moves the cursor beginning of the 

paragraph 

C. Moves the cursor beginning of the screen 

D. Moves the cursor beginning of the line 

ANSWER:D 

 

470. Shortcutkey for Replace 

A. Ctrl+J 

B. Ctrl+F 

C. Ctrl+H 

D. Ctrl+X 

ANSWER:C 

 

471. A tool used to put in cross-head screws. 

A. Phillips head screwdriver 

B. Architect ruler 

C. Flathead screwdriver 

D. Ball peen hammer 

ANSWER: A 

 

472. You suspect that your system is failing to 

boot because of a corrupt master boot record. 

Which utility is the best to fix this? 

A. Device Manager 

B. Task Manager 

C. Recovery Console 

D. Automated System Restore 

ANSWER: C 

 

 

 

 

 

473. You suspect that a virus has entered your 

PC. What will not be affected by the virus? 

A. Program Files 

B. Boot sector 

C. CD in the CD-Drive 

D. CMOS 

ANSWER: D 

 

474. Every video card must have a 

A. Control Unit 

B. ROM 

C. RAM 

D. All of the mentioned 

ANSWER: C 

 

475. Which option of rm command is used to 

remove a directory with all its subdirectories 

A. -b 

B. -o 

C. -p 

D. -r 

ANSWER: D 

 

476. What access rights are required for the 

/etc/shadow file? 

A. -r-------- 

B. -rw-rw-r-- 

C. -r--r----- 

D. -rwxr--r-- 

Answer: A 
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477. Which command will immediately shut 

down a computer running Linux? 

A. shutdown 

B. telinit 6 

C. shutdown now 

D. telinit 0 

Answer: D 

 

478. Which command would give the owner 

and group of myfile the permissions of read and 

execute while all others have read access? 

A. chmod 003 myfile 

B. chmod 554 myfile 

C. chmod 331 myfile 

D. chmod 662 myfile 

Answer: B 

 

479. The PS1 environment variable is used to 

define which of the following? 

A. command path 

B. home directory 

C. shell prompt 

D. signature file 

Answer: C 

 

480. Which of the following directories is used 

to store system utilities used by the superuser? 

A. /etc 

B. /root 

C. /sbin 

D. /usr/local 

Answer: C 


